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One day, Meemaw and I were talking, as we 
often do. We communicate with each other 
about a wide range of topics, not just plans for 
the magazine. After all, we’ve been working 
together closely for over 16 years on producing 
this magazine.

One of our conversations towards the end of 
July involved discussing the distro rankings on 
Distrowatch. Eventually, our conversation 
included that time back in 2008 when 
PCLinuxOS was THE number one distro listed 
in the Distrowatch rankings.

Being #1 is a double-edged sword. On one side 
of the “blade,” it’s an honor to hold the top spot 
in the distro rankings. It’s a good way to get out 
word about our favorite Linux home among 
users of other distros. It’s a “reward” for all of 
the hard work that has gone into producing a 
stable, fast, and useful Linux distro.

But, the other edge of that same “blade” is 
where the real cutting occurs. What does 
everyone want to do to the “king of the 
mountain?” They want to dethrone it, hopeful 
that their favorite distro will supplant the “top 
dog” (which rarely, if ever, happens). As a 
result, the “top dog” in the list draws in all kinds 
of users who have no other agenda other than to 
sabotage and knock that top distro down a few 
pegs.

It’s easy to understand why every user of the 
various Linux distros want to see their favorite 
Linux “home” (distro) listed in the top spot on 
Distrowatch. But, does it really matter?

I can understand the competition between the 
various top-level operating systems. Most of us 
using PCLinuxOS are Windows refugees who 
grew tired of Microsoft’s narrow vision, who 
grew tired of paying large sums of money for 
software, and who grew tired of Windows being 
a literal virus magnet (all for several reasons). 

So, that competition between users of different 
operating systems — Linux, Windows, MacOS 
— is easy to understand.

What’s not so easy to comprehend is the 
tribalism and competition between the various 
Linux distros. We all are, after all, using 
essentially the same operating system. Yes, it’s 
true that there are nuances and differences 
(some subtle, others not so much) between how 
our favorite operating system works. Each 

Ryan & Dad at the 2025 Missouri State Fair, on the Ferris Wheel.

From The Chief Editor's Desk
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“version” or distro of Linux is built differently 
by individuals or entities, and evokes the vision 
that that individual or entity has in mind for how 
Linux should work. PCLinuxOS users are 
fortunate to have Texstar, who has created our 
preferred Linux distro with the idea of being 
stable, fast, has great hardware detection, and 
works well as a desktop replacement for 
Windows (without embracing the Windows 
mindset).

As such, each Linux distro has a piece of its 
creator’s vision for what they think or feel Linux 
should be. But those differences are nothing to 
“go to war” over. If one distro doesn’t fit your 
needs, you move on to another one. In moving 
on, it’s in poor taste to disparage a distro that 
didn’t live up to YOUR idea of what Linux 
should be.

Linux has, it seems, always been about choice. 
You have a choice of programs. You have a 
choice of desktops. You have a choice of 
hardware. You have a choice of distro. So, yes, I 
think it’s safe to say that Linux is all about 
choice. That’s because of the at-large 
community that has sprung up around Linux, 
with input accepted from all walks of life to help 
shape each person’s view of what Linux should 
be.

And, here’s the real “rub” about the Linux 
tribalism: it’s all built around the exact same 
open source code base. With PCLinuxOS, for 
example, ideas, code, implementation plans, and 
configuration options are “borrowed” from just 
about every other Linux distro. Well, at least the 
ones that work. And, PCLinuxOS isn’t the only 

Linux distro to borrow from the other distros. 
They all do it. It is, more or less, how open 
source software works. So, to criticize one distro 
is to potentially criticize your favorite distro.

So, do the Distrowatch “rankings” really matter 
all that much? Granted, users new to Linux, and 
existing Linux users looking for a new Linux 
distro to switch to (or “hop” to), will use the 
rankings on Distrowatch to steer their selection. 
But, where do those numbers come from? Well, 
they come from Distrowatch themselves. That’s 
it. There is NO scientific or statistical relevance 
to anything other than a count of how many 
times the link for a particular distro has been 
clicked on while a user is on the Distrowatch 
website. That’s it. It doesn’t tell anything else. 
What if users went straight to the distro’s 
homepage and downloaded the latest from that 

distro? Nope. Those numbers are not included. 
So, in essence, the Distrowatch “rankings” are 
entirely made up by Distrowatch itself, 
presumably just to generate web traffic. For 
what it’s worth, PCLinuxOS is listed at number 
38 in the rankings list (as of the writing of this 
article). Even Ubuntu and Fedora BARELY 
made it into the top 10.

But, to the rest of us — those of us using 
PCLinuxOS — know that PCLinuxOS is #1. I 
know for me, it has remained my “Linux of 
Choice” for over 18 years, and counting. I’ve 
not had wanderlust for any other Linux distro. 
PCLinuxOS just simply meets my needs, fully.

********************

This month’s cover image was “designed” by 
Meemaw, using Bing Image Generator. She 
decided to try her hand at using AI to create an 
image for this month’s cover. This month’s 
cover “celebrates” the traditional return to 
school from “summer vacation.” And, of course, 
it features Tux teaching a class of baby Tux 
penguins in a classroom setting.

********************

Until next month, I bid you peace, happiness, 
serenity, prosperity, and continued good health!

A magazine just isn't a magazine 
without articles to fill the pages.

If you have article ideas, or if you 
would like to contribute articles to 

the
PCLinuxOS Magazine,

send an email to:
pclinuxos.mag@gmail.com

We are interested in general articles 
about Linux, and (of course), 

articles specific to PCLinuxOS.

DOWNLOAD

Mate Desktop

From The Chief Editor's Desk

mailto:pclinuxos.mag@gmail.com
https://www.bing.com/create
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by Paul Arnote (parnote)

NASA

New observations from the James Webb 
Space Telescope (JWST) are painting a new 
picture of Jupiter's moon Europa and 
revealing the hidden chemistry of the icy 
moon's interior, according to an article from 
Space.com. For decades, scientists pictured 
Europa's frozen surface as a still, silent shell. 
But the new observations reveal that it's actually 
a dynamic world that's far from frozen in time. 
“We think that the surface is fairly porous and 
warm enough in some areas to allow the ice to 
recrystallize rapidly,” Richard Cartwright, a 
spectroscopist at Johns Hopkins University's 
Applied Physics Laboratory and lead author of 
the new study, said in a statement. Perhaps even 
more exciting is what this surface activity 
reveals about Europa's subsurface ocean. The 
presence of geologic activity and ongoing 
cycling between the subsurface and surface 
make “chaos terrains” — highly disrupted 

regions where blocks of ice seem to have broken 
off, drifted and refrozen — especially valuable 
as potential windows into Europa's interior.

Ancient Egyptians sure knew how to stage a 
burial, including canopic jars to hold organs and 
scrolls from the “Book of the Dead” to help the 
deceased navigate the afterlife. In central 
Egypt, archaeologists uncovered one of these 
elaborate scenes: a 3,500­year­old New 
Kingdom cemetery filled with mummies, 
amulets, statues, canopic jars, and a 43­foot­
long papyrus scroll containing part of the 
Book of the Dead, according to an article from 
Popular Mechanics. This scroll is the first 
complete papyrus found in the Al-Ghuraifa area, 
and is “characterized by being in good 
condition,” Mustafa Waziri, secretary general of 
the Egyptian Supreme Council of Antiquities, 
said in a translated Arabic statement from the 
Ministry of Tourism and Antiquities.

Found in everything from protein bars to energy 
drinks, erythritol has long been considered a 
safe alternative to sugar. But new research 
suggests this widely used sweetener may be 
quietly undermining one of the body's most 
crucial protective barriers – with potentially 
serious consequences for heart health and 
stroke risk, according to an article from 
ScienceAlert. A recent study from the University 
of Colorado suggests erythritol may damage 
cells in the blood-brain barrier, the brain's 
security system that keeps out harmful 

substances while letting in nutrients. The 
findings add troubling new detail to previous 
observational studies that have linked erythritol 
consumption to increased rates of heart attack 
and stroke. In the new study, researchers 
exposed blood-brain barrier cells to levels of 
erythritol typically found after drinking a soft 
drink sweetened with the compound. They saw 
a chain reaction of cell damage that could make 
the brain more vulnerable to blood clots – a 
leading cause of stroke.

Image by Katie White from Pixabay

The United Kingdom will move forward with 
its plan to ban all public sector bodies and 
critical national infrastructure from paying 
ransomware attackers, according to an article 
from TechRepublic. The intention is to make 
critical industries “unattractive targets for 
criminals” to reduce the frequency and impact 
of incidents in the country. The ban, which 
would apply to NHS trusts, schools, local 
councils, and data centres, was first proposed in 

ICYMI: UK Moves Forward With Ban
From Paying Ransomware Attackers
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https://www.sciencealert.com/common-sweetener-could-damage-critical-brain-barrier-risking-stroke
https://journals.physiology.org/doi/full/10.1152/japplphysiol.00276.2025
https://www.nature.com/articles/s41591-023-02223-9
https://pixabay.com/photos/ransomware-cybersecurity-cyber-3998798/
https://pixabay.com/users/katielwhite91-5572368/
https://www.techrepublic.com/article/news-uk-ban-ransomware-move-forward/
https://www.techrepublic.com/article/uk-banning-ransomware-payments/
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January. It then underwent several months of 
public consultation, culminating this week in an 
announcement that nearly three-quarters of 
respondents supported the proposal.

Astronomers have discovered a brand­new 
world hiding out beyond Pluto, according to 
an article from BGR.com. While exciting, the 
discovery of this new world could challenge 
long-standing theories of the existence of Planet 
Nine. In fact, the discovery could even kill those 
theories completely. The idea that a ninth planet 
exists in our solar system isn't a new one by any 
means. In fact, scientists have been theorizing 
about it since we officially marked Pluto off the 
planetary lineup (possibly even before, but back 
then it was called Planet X, instead). However, 
finding evidence of a ninth planet has been 
difficult. Not only because of how far away it 
might be — in the outer reaches of our solar 
system — but also just because it doesn't always 
line up with the science we have in front of us. 
Proving that Planet Nine exists shouldn't be this 
difficult. But space is vast. Thankfully, 
researchers say they might have found the key 
to proving Planet Nine's existence. Further, 
some scientists even did the math and estimated 
that there was at least a 40% chance that Planet 
Nine exists.

Four major U.S. agencies have issued a joint 
cybersecurity alert warning about the 
escalating threat posed by the Interlock 
ransomware operation, which has increasingly 
targeted businesses, healthcare providers, and 
critical infrastructure entities across North 
America and Europe, according to an article 
from TechRepublic. The Federal Bureau of 

Investigation (FBI), Cybersecurity and 
Infrastructure Security Agency (CISA), 
Department of Health and Human Services 
(HHS), and the Multi-State Information Sharing 
and Analysis Center (MS-ISAC) released the 
alert Tuesday as part of the #StopRansomware 
initiative. The agencies emphasized Interlock’s 
rapid evolution and its focus on high-impact 
sectors, particularly healthcare. According to the 
advisory, Interlock emerged in September 2024 
and has since launched financially motivated 
ransomware campaigns. The group employs a 
double-extortion model that involves both 
encrypting the victim’s system and stealing data, 
threatening to publish the stolen files if a 
ransom is not paid. The gang does not include 
ransom demands in its initial notes. Instead, 
victims are given a unique code and directed to 
a .onion URL on the Tor network, where ransom 
negotiations take place.

Image by Steve Buissinne from Pixabay

Stevia may provide more benefits than as a 
zero­calorie sugar substitute, according to an 
article from Science Daily. When fermented 

with bacteria isolated from banana leaves, stevia 
extract kills off pancreatic cancer cells but 
doesn't harm healthy kidney cells, according to a 
research team at Hiroshima University. The 
researchers published their findings in the 
International Journal of Molecular Sciences. 
“Globally, the incidence and mortality rates of 
pancreatic cancer continue to rise, with a five-
year survival rate of less than 10%,” said co-
author Narandalai Danshiitsoodol, associate 
professor in Department of Probiotic Science for 
Preventive Medicine, Graduate School of 
Biomedical and Health Sciences. “Pancreatic 
cancer is highly invasive and prone to 
metastasis, showing significant resistance to 
existing treatments, such as surgery, 
radiotherapy, and chemotherapy. As such, there 
is an urgent need to identify new and effective 
anticancer compounds, particularly those 
derived from medicinal plants.” Prior studies by 
other researchers indicated that stevia leaf 
extract demonstrated potential as an anticancer 
drug, but isolating and applying the specific 
bioactive components that protect against cancer 
cells has remained challenging, Danshiitsoodol 
said. However, fermenting with bacteria can 
structurally change the extract and produce 
bioactive metabolites, which are compounds 
that can impact living organisms.

The most commonly taken analgesic 
worldwide – and one of the most consumed 
drugs in the US – could be doing a lot more 
than just pain relief, according to an article 
from ScienceAlert. Acetaminophen, also known 
as paracetamol and sold widely under the brand 
names Tylenol and Panadol, may also increase 
risk-taking, according to research from 2020 

ICYMI: UK Moves Forward With Ban From Paying Ransomware Attackers
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https://pixabay.com/users/stevepb-282134/
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that measured changes in people's behavior 
when under the influence of the medication. 
“Acetaminophen seems to make people feel less 
negative emotion when they consider risky 
activities – they just don't feel as scared,” 
explained neuroscientist Baldwin Way from The 
Ohio State University when the findings were 
published. “With nearly 25 percent of the 
population in the US taking acetaminophen each 
week, reduced risk perceptions and increased 
risk-taking could have important effects on 
society.”

Imagine this. A hacker frantically types code 
into a (punk sticker­laden, if the movies are 
accurate) laptop, trying to get around the 
active firewall that stands between them and 
access to the organization’s information, 
according to an article from CD Insights. It’s 
burdensome work. There’s sweat and a certain 
amount of genius involved. And really, if that 
were an accurate picture of the threat landscape, 
we might have a better idea of how to stop 
breaches from happening. Unfortunately, a 
growing number of incidents are happening 
because the hacker just…gained access through 
credential-based attacks. How does this happen? 
It starts with something called infostealer 
malware, which is small, fast, and widely 
available. These programs quietly infiltrate 
personal or enterprise devices and harvest login 
credentials, browser cookies, and authentication 
tokens. Once captured, those credentials are sold 
or traded on dark web marketplaces. Some go 
for pennies. Others, if they offer access to high-
value enterprise tools like Okta, Salesforce, or 
Microsoft 365, can fetch hundreds or even 
thousands of dollars. And attackers are buying. 

According to the recent 2025 M-Trends report 
from Mandiant and Google Cloud, stolen 
credentials have now overtaken phishing as the 
second most common method of initial access in 
breaches, and this is a significant nugget for 
understanding how the threat landscape is 
shifting. The top spot still belongs to known 
vulnerabilities and exploits, but the credential 
economy is closing the gap. Why? Because it 
works. And because too many organizations still 
treat identity protection as a checkbox, not a 
control surface.

Image by Andreas from Pixabay

Researchers have discovered that the active 
compound in psychedelic mushrooms can 
extend lifespan and reduce cellular aging by 
50% in human cells and 30% in elderly mice, 
according to an article from the 
GoodNewsNetwork. The experiments reveal 
another potential therapeutic use of the 
compound — called psilocybin — which has 
already been studied as a treatment for a myriad 
of other conditions. The team from Emory 
University are calling it the first ever long-term 

study evaluating the systemic effects of 
psilocybin in aged mice. The animals were the 
equivalent of 60 to 65 in biological human 
years, and exhibited hair loss and greying, as 
well as reduced physical activity. The mice were 
dosed with psilocin, the active ingredient in 
psilocybin that appears once the latter is broken 
down during digestion. The mice received a low 
level at first, and eventually a higher dose of 15 
milligrams once a month for 10 months. Within 
the first 3 months, the mice receiving psilocybin 
exhibited signs of youth, including fewer 
instances of greying and hair loss—including a 
reversal of these symptoms — and a general 
improvement in physical activity. By trial’s end, 
the mice that received psilocybin had a 30% 
increased lifespan on average compared to the 
control group.

Scattered Spider is the somewhat too cutesy 
name applied to one of the most dangerous 
threats facing organizations today, according 
to an article from Forbes. The ransomware 
threat actors behind devastating attacks on retail 
and aviation targets, among others, show no 
signs of going away. The Federal Bureau of 
Investigation and the Cybersecurity and 
Infrastructure Security Agency have now 
updated a joint cybersecurity advisory with a 
critical new warning: don’t reset your 
passwords. Here’s what you need to know about 
the latest FBI warning and the ongoing 
Scattered Spider threat. The July 29 update to 
the FBI and CISA cybersecurity advisory, alert 
code AA23-320A, warns that Scattered Spider 
has “posed as employees to convince IT and/or 
helpdesk staff to provide sensitive information, 
reset the employee’s password, and transfer the 
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employee’s MFA to a device they control on 
separate devices.”

Breast cancer patients who have been in 
remission for years or even decades may still 
need to be cautious about respiratory 
infections, according to an article from 
ScienceAlert. Some common viruses may re-
awaken a very small number of dormant breast 
cancer cells within our lungs, according to 
emerging research. “Dormant cancer cells are 
like the embers left in an abandoned campfire, 
and respiratory viruses are like a strong wind 
that reignites the flames,” argues molecular 
geneticist James DeGregori from the University 
of Colorado. The research began following the 
COVID-19 pandemic, when DeGregori and his 
colleagues began to notice a curious uptick in 
cancer cases. To find out more, the international 
team turned to human population studies and 
mouse models. They found that patients in 
remission for cancer in the UK Biobank who 
tested positive for SARS-CoV-2 later showed a 
twofold increase in cancer-related death.

When a multimillion-dollar extraterrestrial 
vehicle gets stuck in soft sand or gravel — as 
did the Mars rover Spirit in 2009 — Earth-based 
engineers take over like a virtual tow truck, 
issuing a series of commands that move its 
wheels or reverse its course in a delicate, time-
consuming effort to free it and continue its 
exploratory mission. While Spirit remained 
permanently stuck, in the future, better 
terrain testing right here on terra firma could 
help avert these celestial crises, according to 
an article from Science Daily. Using computer 
simulations, University of Wisconsin-Madison 
mechanical engineers have uncovered a flaw in 
how rovers are tested on Earth. That error leads 
to overly optimistic conclusions about how 
rovers will behave once they're deployed on 
extraterrestrial missions. An important element 
in preparing for these missions is an accurate 
understanding of how a rover will traverse 
extraterrestrial surfaces in low gravity to prevent 
it from getting stuck in soft terrain or rocky 
areas. On the moon, the gravitational pull is six 
times weaker than on Earth. For decades, 
researchers testing rovers have accounted for 

that difference in gravity by creating a prototype 
that is a sixth of the mass of the actual rover. 
They test these lightweight rovers in deserts, 
observing how it moves across sand to gain 
insights into how it would perform on the moon. 
It turns out, however, that this standard testing 
approach overlooked a seemingly 
inconsequential detail: the pull of Earth's gravity 
on the desert sand. Through simulation, Dan 
Negrut, a professor of mechanical engineering at 
UW-Madison, and his collaborators determined 
that Earth's gravity pulls down on sand much 
more strongly than the gravity on Mars or the 
moon does. On Earth, sand is more rigid and 
supportive — reducing the likelihood it will 
shift under a vehicle's wheels. But the moon's 
surface is “fluffier” and therefore shifts more 
easily — meaning rovers have less traction, 
which can hinder their mobility.

New research from Edith Cowan University 
has found that just one session of exercise, 
either resistance or high­intensity interval 
training, can trigger anti­cancer effects in 
breast cancer survivors, according to an article 
from SciTechDaily. New findings from Edith 
Cowan University (ECU) suggest that just one 
session of resistance training or high-intensity 
interval training (HIIT) may support the body’s 
ability to fight cancer. PhD researcher Francesco 
Bettariga discovered that a single workout can 
boost the production of myokines—proteins 
released by muscles during exercise that are 
known to have anti-cancer properties. His data 
showed that these proteins could potentially 
slow cancer cell growth by 20-30%.
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A virus normally found in black­eyed peas is 
emerging as a powerful ally in the fight 
against cancer, according to an article from 
SciTechDaily. Scientists discovered that this 
plant virus, called CPMV, doesn’t infect human 
cells — but it does trigger a potent immune 
response, training the body to recognize and 
destroy cancer cells. Unlike typical therapies, it 
primes both innate and adaptive immunity, 
offering long-term protection. A virus known for 
infecting black-eyed peas is now emerging as a 
surprisingly powerful tool in cancer treatment, 
and scientists are beginning to understand why. 
Researchers from the University of California 
San Diego, led by a team of chemical and nano 
engineers, recently published a study in Cell 
Biomaterials that dives into how the cowpea 
mosaic virus (CPMV) stimulates the human 
immune system in a way that other plant viruses 
do not. Unlike its viral relatives, CPMV appears 
to uniquely trigger immune cells to recognize 
and fight cancer.

ESA/Hubble, M. Kornmesser

The saga surrounding Neptune­size “super­
Earth” exoplanet K2­18 b just got a whole lot 
more interesting, according to an article from 

Space.com. For a quick recap, this is the world a 
team of scientists recently suggested could host 
life — to the dismay of other scientists in the 
community, who felt the announcement failed to 
include necessary caution. While signs of life on 
the world have failed to conclusively present 
themselves to the James Webb Space Telescope 
(JWST), the powerful space telescope has 
discovered that this planet is so rich in liquid 
water that it could be an ocean, or “Hycean” 
world. “This has certainly increased the chances 
of habitability on K2-18 b” Nikku 
Madhusudhan, the University of Cambridge 
scientist behind the original K2-18b discovery 
as well as the new study, told Space.com. “This 
is a very important development and further 
increases the chance of a Hycean environment 
in K2-18 b. It confirms K2-18 b to be our best 
chance to study a potential habitable 
environment beyond the solar system at the 
present time.”

Zealandia had so much promise as the eighth 
continent on Earth. Well, it did — until about 
95 percent of the mass sunk under the ocean, 
according to an article from Yahoo! News. 
While the majority of Zealandia may never host 
inhabitants—at least, not land-based ones—the 
would-be continent is now no longer simply 
lost. Researchers have finished mapping out the 
northern two-thirds of Zealandia, wrapping up 
the documentation of the nearly two million 
square miles of the submerged land mass. In a 
study published in Tectonics, researchers from 
GNS Science of New Zealand document their 
process of dredging rock samples from the 
Fairway Ridge to the Coral Sea in order to 
analyze the rock geochemistry and understand 

the underwater makeup of Zealandia. 
Zealandia’s history is quite closely tied to the 
ancient supercontinent of Gondwana, which 
broke up hundreds of millions of years ago. 
Zealandia followed suit—roughly 80 million 
years ago, according to the latest theory. But 
unlike neighboring Australia or much of 
Antarctica, Zealandia largely sank, leaving only 
a small portion of what many geologists believe 
should still be dubbed the eighth continent. New 
Zealand makes up the most recognizable above-
water portion of Zealandia, although a few other 
islands in the vicinity are also part of the maybe-
continent in question.

Malwarebytes Labs has identified a phishing 
scheme that begins with an email appearing 
to be from Instagram asking users to confirm 
their identity because someone has just tried 
to log into their account, according to an 
article from Lifehacker. The text includes a 
verification code and a link to “report this user 
to secure your account” as well as remove your 
email address. Campaigns like this often send 
users to a phishing website, where they are 
prompted to enter their credentials or other 
personal identifying information. In some cases, 
the fake sites have tech support chatbots or list 
step-by-step instructions to “fix” an issue. No 
matter the tactic, threat actors are trying to 
obtain enough information to steal your identity, 
your money, or both by capitalizing on your fear 
and sense of urgency to secure your account. 
What's different about this Instagram scam is 
what happens when you click the links in the 
email. Instead of a fraudulent website, the text is 
a mailto: link, which opens the default email 
program on your device with a pre-filled 
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https://scitechdaily.com/this-virus-doesnt-make-you-sick-it-makes-you-stronger/
https://www.space.com/space-exploration/search-for-life/nearby-super-earth-k2-18-b-may-be-a-water-rich-ocean-planet-this-has-certainly-increased-the-chances-of-habitability
https://ca.news.yahoo.com/earth-hidden-eighth-continent-no-141900752.html
https://agupubs.onlinelibrary.wiley.com/doi/10.1029/2023TC007961
https://lifehacker.com/tech/instagram-mailto-email-scam
https://www.malwarebytes.com/blog/news/2025/07/watch-out-instagram-users-targeted-in-novel-phishing-campaign
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recipient and subject line like “Report this user 
to secure your account” or “Remove your email 
address from this account.” The email addresses 
in the recipient lines appear relatively 
trustworthy—though none direct back to 
Instagram, which is what you'd expect—thanks 
to a tactic known as typosquatting. Ultimately, 
though, they connect back to servers run by 
threat actors, and hitting “send” on your end 
validates that your email address is active and 
ripe for further targeting.

Image by Alexandra Koch from Pixabay

A new AI model from Singapore­based 
Sapient Intelligence is challenging the “bigger 
is better” mantra dominating today’s AI 
model development, and it’s doing it by 
copying a trick from the human brain or, at 
least, how we think the brain works, 
according to an article from TechRepublic. Meet 
the Hierarchical Reasoning Model (HRM), a 
tiny 27M-parameter design that solves complex 
reasoning puzzles that leave today’s massive AI 
models completely stumped. The problem with 
models like ChatGPT, according to the 
researchers, is that they’re architecturally 
“shallow.” They rely on Chain-of-Thought 
(CoT) prompting — basically, talking 

themselves through a problem step-by-step — 
as a crutch. But with CoT, one wrong turn can 
derail the whole process. HRM takes a different 
approach. On the ARC-AGI benchmark, which 
is basically an IQ test for AI, HRM went head-
to-head with top-tier models and dominated. On 
Sudoku-Extreme puzzles, HRM solved 55% of 
them. Claude 3.7 and OpenAI’s o3-mini-high? 
They scored 0%. On 30×30 mazes, HRM found 
the optimal path 74.5% of the time. The others? 
0% again.

If you still use Gmail as your primary email 
service, this tip is for you. Gmail's new feature 
will let you get an overview of your existing 
subscriptions and bulk unsubscribe with a 
few taps, according to an article from CNET. 
Previously, when you viewed an email 
newsletter, an “unsubscribe” option would 
appear at the top so you could quickly 
unsubscribe with a single tap or click, but that 
would (obviously) only work for the individual 
newsletter. The new feature centralizes all of 
your newsletter subscriptions so you can 
declutter unnecessary future emails with ease. 
Look for “Manage Subscriptions” (just under 
Categories) in the left pane of the Gmail 
window.

Google’s LLM­powered vulnerability sleuth, 
Big Sleep, just reported its first haul of 
security flaws — 20 bugs lurking in widely 
used open source tools, like FFmpeg, 
ImageMagick, cups­filters, and QuickJS, 
according to a post on X (formerly Twitter). 
Developed by DeepMind and Project Zero, the 
AI autonomously identified and reproduced the 
vulnerabilities, with a human in the loop only 

for final verification. While details remain under 
wraps until fixes roll out, Google hails this as a 
milestone in automated vulnerability hunting. 
Big Sleep just proved AI can hunt security bugs 
while the rest of us are still waking up. You can 
view the bug reports here.

Cybersecurity researchers have discovered a 
nascent Android remote access trojan (RAT) 
called PlayPraetor that has infected more 
than 11,000 devices, primarily across 
Portugal, Spain, France, Morocco, Peru, and 
Hong Kong, according to an article from The 
Hacker News. “The botnet's rapid growth, 
which now exceeds 2,000 new infections per 
week, is driven by aggressive campaigns 
focusing on Spanish and French speakers, 
indicating a strategic shift away from its 
previous common victim base,” Cleafy 
researchers Simone Mattia, Alessandro Strino, 
and Federico Valentini said in an analysis of the 
malware. PlayPraetor, managed by a Chinese 
command-and-control (C2) panel, doesn't 
significantly deviate from other Android trojans 
in that it abuses accessibility services to gain 
remote control and can serve fake overlay login 
screens atop nearly 200 banking apps and 
cryptocurrency wallets in an attempt to hijack 
victim accounts.
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https://pixabay.com/photos/ai-generated-robot-android-human-7718642/
https://pixabay.com/users/alexandra_koch-621802/
https://www.techrepublic.com/article/news-ai-hierarchical-reasoning-model/
https://www.cnet.com/tech/services-and-software/gmails-new-feature-lets-you-clean-up-your-inbox-in-a-couple-of-taps/
https://blog.google/products/gmail/new-manage-subscriptions-unsubscribe/
https://x.com/argvee/status/1952390039700431184?email_hash=afaf0114c5d98ce7f0998f229ffbf379
https://thehackernews.com/2025/08/playpraetor-android-trojan-infects.html
https://www.cleafy.com/cleafy-labs/playpraetors-evolving-threat-how-chinese-speaking-actors-globally-scale-an-android-rat
https://issuetracker.google.com/issues?q=componentid:1836411&s=type:desc&s=issue_id:desc&pli=1


PCLinuxOS Magazine Page 11

Google has been hacked. Source? That would 
be Google itself, according to an article from 
Forbes. An August 5 posting by the Google 
Threat Intelligence Group has confirmed that 
one of the corporate databases was impacted by 
hackers thought to be associated with the 
ShinyHunters ransomware group, more formally 
known as UNC6040. “Google responded to the 
activity, performed an impact analysis and 
began mitigations,” the GTIG posting stated, 
adding the database in question was a Salesforce 
instance “used to store contact information and 
related notes for small and medium businesses.” 
Customer data was, Google said, “retrieved by 
the threat actor,” in the short period of time that 
the attack window remained open. Although 
Google has not gone into great detail regarding 
the attack as of yet, it did confirm that the stolen 
data consisted of “basic and largely publicly 
available business information, such as business 
names and contact details.”

A common type of human papillomavirus 
(HPV) could be more dangerous than we 
thought, according to an article from 
ScienceAlert. The virus, known as beta-HPV, 
was thought in rare cases to contribute to skin 
cancer by worsening UV damage, but a new 
study suggests it can actually hijack the body's 
cells to directly drive cancer growth. These fresh 
conclusions came from a study of a 34-year-old 
woman who sought medical help for cutaneous 
squamous cell carcinoma (cSCC) on her 
forehead. Her tumors were repeatedly growing 
back, even after immunotherapy and surgeries. 
A closer genetic analysis revealed something 
surprising: the beta-HPV had actually integrated 
itself into the DNA of the woman's tumor, where 

it was producing viral proteins that helped the 
cancer thrive.

NASA

‘Float rocks,’ sand ripples, and vast distances 
are among the sights to see in the latest high­
resolution panorama by the six­wheeled 
scientist, according to an article from NASA 
JPL. The imaging team of NASA’s Perseverance 
Mars rover took advantage of clear skies on the 
Red Planet to capture one of the sharpest 
panoramas of its mission so far. Visible in the 
mosaic, which was stitched together from 96 
images taken at a location the science team calls 
“Falbreen,” are a rock that appears to lie on top 
of a sand ripple, a boundary line between two 
geologic units, and hills as distant as 40 miles 
(65 kilometers) away. The enhanced-color 
version shows the Martian sky to be remarkably 
clear and deceptively blue, while in the natural-
color version, it’s reddish.

According to an article from NewAtlas.com, 
green tea extract and vitamin B3 combo may 
hold the key to reviving the brain’s natural 
cleanup crew, restoring energy, clearing toxic 
Alzheimer’s proteins, and giving aging 
neurons a second wind, according to new 
research. Although the largest risk factor for 
Alzheimer’s disease is age, the age-related 
mechanisms that contribute to that risk aren’t 
clear. While some propose that a buildup of 
toxic amyloid-beta proteins is to blame, others 

say the condition is caused by an imbalance in 
cellular energy supply and demand. A new study 
by researchers from the University of California, 
Irvine has found that a combination of two 
natural compounds, readily available as dietary 
supplements, helps revive the brain’s natural 
cleanup system that removes damaged parts and 
toxic buildup.

Are you a Star Trek fan? If so, prepare to 
rejoice. During the Star Trek panel in Hall H at 
the San Diego Comic Con, Star Trek: Strange 
New Worlds showrunners Akiva Goldsman and 
Henry Alonso Myers made it known that they 
had an endgame in mind, according to an article 
from CBR. They want to explore Star Trek: 
Year One, a Captain Kirk-focused sequel and 
spinoff of sorts that traces Kirk in his very first 
year as captain. This would star Paul Wesley and 
continue on in the same continuity. It's an 
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intriguing idea and one that already has a fan 
base ready, considering the popularity of the 
new iteration of the character.

Lenovo Performance Full HD Webcam

Eclypsium researchers have discovered 
vulnerabilities in USB webcams that allow 
attackers to turn them into BadUSB attack 
tools, according to an article from Eclysium. 
This allows remote attackers to inject keystrokes 
covertly and launch attacks independent of the 
host operating system. Principal security 
researchers Jesse Michael and Mickey Shkatov 
presented this research at DEF CON 2025. 
Eclypsium researchers discovered that select 
model webcams from Lenovo run Linux, do not 
validate firmware, and can be weaponized as 
BadUSB devices. To our knowledge, this is the 
first time it has been demonstrated that attackers 
can weaponize a USB device that is already 
attached to a computer that was not initially 
intended to be malicious. Two attack paths are 
possible: 1) An attacker can send someone a 
backdoored webcam (or, with physical access, 
attach a weaponized webcam to a computer) or 

2) remotely compromise a computer and infect 
the Linux-based webcam to perform attacks. 
While this research focuses on two models of 
Lenovo webcams, other webcams and USB 
peripherals that run Linux may also be 
vulnerable. Attackers who gain control of 
Linux-based USB peripherals could also launch 
other attacks, depending on the device 
capabilities, including interacting with WiFi 
and/or Bluetooth. Detecting these attacks is 
challenging, as the malicious USB device could 
re-infect the host and provide stealth and 
persistence to the attacker(s).

In the endless saga of hacks and data breaches, 
it's practically guaranteed that at least some of 
your personal information is available on the 
internet. But that doesn't mean you shouldn't 
take steps to remove or protect it wherever you 
can — including from databases that have a 
history of being compromised. National Public 
Data, a background check company operated 
by Jerico Pictures Inc., was the target of a 
massive hack in early 2024, which led to the 
leak of billions of records containing data 
(culled from non­public sources) like Social 
Security numbers, according to an article from 
Lifehacker. The site has since returned under 
new ownership as a “free people search engine” 
and, while it purports to rely on publicly 
available information, you still can (and should) 
remove your records. If nothing else, doing so 
means one less place where people can easily 
find your address, phone number, and other 
personal information. I looked up my 
information, and a significant portion of the 
“information” was blatantly wrong. Removing

my data from the database was super easy, 
following the instructions in the article.

Reddit has started blocking The Internet 
Archive (IA) from archiving most of its 
platform, according to an article from eWeek. 
The company says the move was prompted by 
concerns that AI developers were pulling 
Reddit-originated data from archived pages, 
something IA has not been able to stop. The IA 
regularly archived Reddit content, including 
original posts and comment threads to user 
profiles. Even if a post was deleted by the 
original author, a snapshot often remained 
available on the Wayback Machine. Deleted user 
profiles were even made available on the 
archive. While this information could easily be 
found by any tech-savvy Reddit user, the real 
issue arose when automated bots started using 
the IA to scrape data for use in their own AI 
models. The problem escalated when automated 
programs began using those archives to gather 
large amounts of data for AI training. Because 
the platform bans automated scraping without 
approval, Reddit argues it had little choice but to 
limit IA’s access when the archive could not 
reliably block these activities. Tim Rathschmidt, 
a spokesperson for Reddit, was recently quoted 
as saying: “Until they’re able to defend their site 
and comply with platform policies (e.g., 
respecting user privacy, re: deleting removed 
content) we’re limiting some of their access to 
Reddit data to protect redditors.” The restriction 
does not cut off IA entirely; the Wayback 
Machine can still capture Reddit’s homepage 
but not full posts, comments, or subreddit pages.
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Image by Jan from Pixabay

Now here’s a use of AI that we can all get 
behind. With help from artificial intelligence, 
MIT researchers have designed novel 
antibiotics that can combat two hard­to­treat 
infections: drug­resistant Neisseria 
gonorrhoeae and multi­drug­resistant 
Staphylococcus aureus (MRSA), according to 
an article from MIT News. Using generative AI 
algorithms, the research team designed more 
than 36 million possible compounds and 
computationally screened them for antimicrobial 
properties. The top candidates they discovered 
are structurally distinct from any existing 
antibiotics, and they appear to work by novel 
mechanisms that disrupt bacterial cell 
membranes. This approach allowed the 
researchers to generate and evaluate theoretical 
compounds that have never been seen before — 
a strategy that they now hope to apply to 
identify and design compounds with activity 
against other species of bacteria.

According to an article from The Times, 
Russian intelligence has tripled its 

cyberattacks on Poland this year and 
Warsaw is steeling itself for an attempt to 
shut down the water supply or the power 
grid, the country’s deputy prime minister has 
said. In an interview with The Times, Krzysztof 
Gawkowski, who also runs the digital ministry, 
said there had been more than 100,000 attempts 
to compromise Poland’s computer networks last 
year, equating to roughly 300 a day. On 
Thursday, a few days after the interview, his 
warning was vindicated as he announced that 
the security services had foiled a cyberattack on 
the water and sewage systems of a “large city” 
at the last minute. Gawkowski argues that 
Russia is locked in an ongoing “war” with 
Poland in cyberspace. In recent months, security 
agencies from the US, the UK and more than a 
dozen other countries have warned that the 
Russian state and its proxies are stepping up an 
already intense “cyber campaign” against 
western targets involved in providing aid to 
Ukraine.

These days, the internet and Wi-Fi connectivity 
seem to be virtually ubiquitous. In the US, at 
least, there is a societal expectation that you can 
connect your devices to the web wherever you 
go. After all, connectivity is essential for many 
devices to function. But sometimes that 
connectivity fails — and what can you do if 
you want to watch TV without the internet? 
Here's what you can do: use a USB flash 
drive, according to an article from ZDNet. Most 
modern smart TVs have built-in media players 
that read content from USB devices. The range 
of benefits for using a USB drive is abundant. 
You can play your selected media files without 
streaming or connecting with multiple devices. 

Using a drive is cost-effective; you can store a 
large library of content on a USB stick and 
avoid monthly streaming subscriptions. And you 
have increased flexibility because you can use 
the USB stick to play content on pretty much 
any TV manufactured since 2001.

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...
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by Meemaw

I saw another tutorial by Davies Media Design 
that you might enjoy. This could be useful in 
photo editing to add a title to a photo for an 
album. It’s a nice effect because it makes part of 
the photo visible through the text.

I used a photo of the harbor in Seward, Alaska 
(we went there on vacation in 2017). Load it 
first.

To put the text in, choose the text tool. You can 
change the color to white, choose the font and 
size before you type. In the tutorial, Davies 
changed the kerning (distance between the 
letters) as well, but that’s a personal choice. 
Type your text. You’ll notice that GIMP puts the 
text on a separate layer, which is what you want.

Choose Layer > Crop to content. This will turn 
off the text information, but if you’ve made a 
mistake, you can choose the text tool again.

You can do this any time in your steps, but this 
is where his video has it. To make sure 
everything is centered (if that’s how you want 
it), you should add a vertical guide in your 
project. Choose Image > Guides >New by 
percent and make it 50% to center the guide. 
You can always delete it when you’re finished. 
When you choose the Move tool, and grab the 
text, you’ll see a plus sign in the middle that you 
can line up with the guide.

Now we’re going to add our frame. Create a 
new transparent layer (he named it “Text box,” 
but that’s up to you). Move that layer between 
the text and the photo layers. Choose your 
Rectangle select tool, and draw a rectangle a bit 
bigger than your text and fill it with black. A 
shortcut you might not remember is to grab the 
black color chip from the color palette and drag 
it on top of the rectangle, which will fill it (right, 
top).

Again, choose Layer > Crop to content to 
make the box layer the size of the box. Choose 
Select > None, then change to the Alignment 
tool (next to the Move tool). Select the box 
layer, then the text layer, and align your items 
horizontally (they should be already because of 
the guide), and then vertically, which will center 
the text in the box.

Choose Select > None again, then select the text 
layer and click Layer > Transparency > Alpha 
to selection. The selection needs to remain this 
time. Now select the box layer and click on the 
Layer Mask tool, which is at the bottom of the 
layers window next to the Delete layer button.

Your layer mask setting should be changed to 
”Selection”, and “Invert” should be checked, as 
shown here. Your layers dialog should look like 
the next image as well (next page, top left).

Linux is Our Passion

GIMP Tutorial: Create Transparent Cutout Text

https://destinationlinux.org
https://www.youtube.com/watch?v=YF-J-PM47hk 
https://www.youtube.com/@DaviesMediaDesign
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Now, go back to your text layer and turn off the 
visibility. You should be able to see through to 
your photo. Neat, huh?

I also made one using a local sight. In Southeast 
Kansas years ago, they did coal mining with 
huge diggers. One of the remaining electric 
shovels, affectionately named Big Brutus, is 
parked in Weir, KS and is now a museum.
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GIMP Tutorial: Create Transparent Cutout Text
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Serves: 4

INGREDIENTS:

1 lb steak (ribeye or sirloin), sliced into strips
12 oz fettuccine pasta
2 cups heavy cream
1 cup Parmesan cheese, grated
1 tbsp Cajun seasoning
2 tbsp butter
1 tbsp olive oil
2 cloves garlic, minced
1 small onion, diced
1/4 cup fresh parsley, chopped
Salt and pepper to taste

DIRECTIONS:

Cook the fettuccine pasta according to package 
instructions until al dente. Drain and set aside.

Heat olive oil in a large skillet over medium-
high heat. Season the steak strips with salt, 
pepper, and Cajun seasoning. Cook the steak for 
3-4 minutes until browned and cooked to your 
desired level of doneness. Remove the steak 
from the skillet and set aside.

In the same skillet, melt the butter. Add the 
garlic and onion, cooking for 2-3 minutes until 
softened and fragrant.

Pour in the heavy cream, bring to a simmer, and 
cook for 3-5 minutes until slightly thickened.

Stir in the grated Parmesan cheese and cook 
until the sauce is smooth and creamy.

Add the cooked pasta and steak strips to the 
sauce, tossing to coat everything evenly. Cook 
for 1-2 minutes to heat through.

Garnish with fresh parsley and serve warm.

NUTRITION:

Calories: 650     Carbs: 45g     Sodium: 559mg 
Fiber: 6g            Protein: 48g

PCLinuxOS Recipe Corner

Creamy Cajun Steak Alfredo

http://www.pclinuxos.com
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Hazem Abbas
MEDevel.com
Reprinted with permission

The Impact of Linux on My Journey as 
a Doctor, Developer, and Instructor

Linux has been more than just an operating 
system for me — it’s been a companion, a 
mentor, and a tool that’s shaped how I think and 
work. My journey with Linux started back in 
1999. As someone who was already juggling the 
complexities of medical school, I was drawn to 
Linux for its simplicity and stability — two 
things that often felt missing in other operating 
systems.

I started with Slackware, then moved through 
Debian, RedHat, PCLinuxOS, Ubuntu and 
finally Manjaro. Each switch wasn’t just about 
trying a new system — it was an exploration, a 
challenge, and a chance to learn.

My minimum use for any Linux distro is two 
years — I never recommend switching or 
distro­hopping frequently. Constantly 
jumping from one distro to another prevents 
you from gaining the stability needed to truly 
learn and grow. Stick with one, explore its 
depths, and remember: everything is 
customizable, so face the problems head­on 
and solve them.

Over the years, I’ve had the chance to use some 
incredible but now-discontinued Linux distros 
like Dreamlinux, Moblin Linux, and 
CrunchBang Linux.

Each of these had its charm — Dreamlinux 
impressed with its Mac-like aesthetics, Moblin 
was a bold step towards a mobile-centric future, 
and CrunchBang (#!) was the minimalist’s 
dream, designed for speed and simplicity.

What stands out the most, though, is the vibrant 
CrunchBang Linux IRC channel. It was more 
than a support space — it was a thriving 
community where users exchanged ideas, solved 
problems, and formed connections. It remains 
one of the best Linux communities I’ve ever 
been part of, a testament to the power of open-
source collaboration.

DreamLinux 2007

Over the years, I’ve experimented and used 
LinuxMint, Arch Linux, Manjaro, Solus, and 
Deepin, but I’ve ultimately settled with Manjaro 
as my daily driver.

Why? Because Manjaro strikes a balance 
between simplicity and power. It’s stable, it’s 
fast, and it just works — whether I’m 
developing software, teaching a class, or 
working on something completely unrelated, 
like horse training.

Linux: More Than an Operating System

One of the reasons I recommend Linux so 
passionately to friends, colleagues at med school 
in the early 2000s, and even my med school 
classmates is that it offers something far deeper 

The PCLinuxOS Magazine
Created with Scribus

Why Linux Is The Ultimate Mental Gym For Problem-
Solvers; A Doctor & An Equestrian's Journey

http://www.scribus.net
https://medevel.com/author/hazem/
https://medevel.com/why-linux-is-the-ultimate-mental-gym/
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than the surface-level advantages of other 
platforms.

Crunchbang Linux while using 2009

Sure, the benefits like stability, security, 
privacy, and customization are great. But the 
hidden value of Linux lies in the mental 
discipline it cultivates.

For those who’ve never used Linux for at least 
three to five years, I truly believe they’ve 
missed out on learning how to approach a 
problem. Problem-solving, critical thinking, 
and resourcefulness are skills I sharpened not 
just through my education, but through my 
Linux experience.

I recommended Linux not just to my fellow 
developers, but also to doctors who’d spend 
countless hours gaming or relying on overly 
polished software.

I believed then — and still do — that using 
Linux is a mental exercise, a form of problem-
solving practice that teaches you how to face 
challenges head-on.

From Shell to Saddle: How Linux Prepared 
Me for Horse Riding and Training

Owning horses and embracing a lifestyle of 
regular riding and training taught me valuable 
lessons, but it wasn’t until a 30-mile solo 
horseback journey that I realized how deeply 
Linux shaped my approach to this new passion.

Just like every Linux distro I’ve explored, each 
horse brings its unique traits, temperament, and 
challenges.

Training or riding a horse feels strikingly similar 
to installing and adapting to a new Linux distro 
— it requires understanding its character, 
finding the right “configuration,” and solving 
problems as they arise.

This mindset, honed through years of using 
Linux, has made me adaptable, patient, and 
solutions-oriented, both in the command line 
and the saddle.

So, when someone says: “your horse is 
dangerous, how you managed to tame and train 
it like this”, The first answer that comes to my 
mind is: “It is just another Linux distro for me”.

Why Linux Is The Ultimate Mental Gym For Problem-Solvers; A Doctor & An Equestrian's Journey

https://www.instagram.com/hmzemadm/
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The Obvious Advantages of Linux

To appreciate the full scope of Linux’s impact, 
it’s important to start with its clear and 
undeniable advantages:

Stability: Linux rarely crashes. Period.

Security: Viruses are almost non-existent in the 
Linux world.

Privacy: Linux gives you control over your 
data, something other operating systems rarely 
prioritize.

Customization: You can tweak and adjust 
everything to suit your workflow.

Performance: It runs smoothly on older 
computers, extending their lifespan.

Software Updates: Regular, reliable updates 
that improve performance without breaking 
things.

Diverse Software: Hundreds of open-source 
alternatives for every proprietary software you 
can imagine.

Experimentation: You’re encouraged to try, 
fail, and learn — without restrictions.

Less Gaming: Yes, gaming is possible on 
Linux, but not as tempting. This, in turn, means 
fewer distractions.

The Hidden Advantages

Beyond the obvious, Linux taught me skills I 
never expected to gain from an operating 
system:

Challenging Yourself: Linux constantly pushes 
you to learn and adapt.

Improving Problem­Solving: Debugging an 
issue, fixing a broken update, or configuring 
software builds resilience and analytical 
thinking.

Productivity: The lack of distractions, coupled 
with efficient tools, means more time spent on 
meaningful work.

Mental Sport: It’s like solving a puzzle every 
day. Each problem is an opportunity to grow.

Open Source Values: You learn to appreciate 
and contribute to a community-driven 
ecosystem.

Understanding Internals: From the kernel to 
package management, Linux teaches you how 
operating systems actually work.

Better Development Practices: Whether it’s 
coding on Linux or deploying servers, it’s a 
developer’s playground.

Mastering the Command Line: The terminal 
isn’t just a tool; it’s a superpower.

Improved Search Skills: Searching forums, 
reading documentation, and finding solutions 
become second nature.

Why Linux is a Mental Game

Using Linux is about more than functionality — 
it’s about cultivating a mindset. Every 
configuration, every bug, every tweak teaches 
you something new.

It’s a lifestyle that promotes curiosity and 
problem-solving.

FREE!

Original SciFi Books 
By PCLinuxOS's

Own arjaybe!

Download Today!

Why Linux Is The Ultimate Mental Gym For Problem-Solvers; A Doctor & An Equestrian's Journey
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For me, it’s also been about the joy of discovery. 
When you finally solve a problem you’ve been 
stuck on, it’s not just relief — it’s exhilaration. 
And that exhilaration translates into confidence, 
both personally and professionally.

My Experience in Points:

Adapting to Differences: Like Linux distros, 
every horse has its unique traits and requires a 
tailored approach.

Problem­Solving: Both horses and distros 
present challenges that demand patience, 
analysis, and creative solutions.

Learning Patterns: Training a horse is akin to 
learning a new OS — understanding its 
behavior and quirks is essential.

Customization: Just as Linux allows infinite 
customization, working with horses teaches you 
to adapt your techniques to fit each individual.

Patience and Persistence: The long journey of 
mastering a horse mirrors the learning curve of 
mastering Linux — neither offers shortcuts.

Mental Growth: Both activities improve focus, 
resilience, and adaptability, making you more 
resourceful in life.

Meditation and Reflection: Horseback riding 
offers a meditative escape, much like the 
satisfaction of solving a tricky Linux problem.

Consistency: Commitment to a distro — or a 
horse — over time reveals deeper rewards and 
teaches discipline.

Enjoying the Journey: Whether it’s a long trail 
ride or troubleshooting a system, the process 
itself is deeply fulfilling.

Community and Sharing: Both Linux and 
horse riding involve learning from others, 
sharing knowledge, and growing together.

My Advices for Linux Users and Newcomers

“Stick with one Linux distro long enough to 
learn its depths—stability breeds growth.”

“Facing problems head-on in Linux mirrors 
solving challenges in life: patience and 
persistence are key.”

“Switching distros often might feel exciting, 
but it prevents you from mastering the art of 
problem­solving.”

“Linux is more than an operating system; it’s a 
mindset that cultivates creativity and resilience.”

“Every bug is a hidden lesson; solving it 
sharpens your mind and strengthens your 
confidence.”

“The best communities, like CrunchBang’s IRC, 
remind us that open-source is as much about 
people as it is about code.”

“Customizing Linux isn’t just about tailoring 
software—it’s about taking control of your 
workflow and thinking.”

“Challenges in Linux aren’t roadblocks; they’re 
stepping stones to better problem-solving 
skills.”

“The journey with Linux is a mental exercise
—one that transforms frustration into 
growth.”

“To truly appreciate Linux, stop looking for 
perfection and start embracing its potential for 
endless learning.”

Final Thought

Linux is not for everyone, and that’s okay. But 
for those who stick with it, the rewards go far 
beyond a faster computer or a more secure 
system. It’s a way to sharpen your mind, 
challenge your assumptions, and learn to love 
problem-solving.

Why Linux Is The Ultimate Mental Gym For Problem-Solvers; A Doctor & An Equestrian's Journey
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If you’ve never tried Linux — or gave up after 
a few months — I encourage you to give it 
another shot.

Not just because it’s free, secure, and 
customizable, but because it teaches you how to 
think. And in a world that increasingly demands 
creativity and critical thinking, that’s a skill 
worth cultivating.

Linux has been a cornerstone in my life — not 
just as an OS but as a mindset. It’s not just about 
what Linux can do for you, but what you can 
become because of it.

About The Site & Author

Medevel.com is a restart of an old project, Goomedic.com 
when we used to blog about medical/ healthcare related 
open-source projects. The writers are also medical 
doctors doing software development, as well as open-
source enthusiasts and Advanced Linux users.

Medevel.com is writing articles about open source with a 
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Medevel.com is on a mission to promote open source to 
healthcare sector users like doctors, nurses, healthcare IT 
specialists, open-source community, researchers.
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medical imaging, lab-ware, medical records (EMR, EHR), 
clinical practice management software, digital 
pathology, medical simulation, & data analytics apps.
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• Medical Visualization & Simulation
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Authors
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SSccrreeeennsshhoott  SShhoowwccaassee

1. All the contents of the PCLinuxOS Magazine are only for general 

information and/or use. Such contents do not constitute advice and should 

not be relied upon in making (or refraining from making) any decision. Any 

specific advice or replies to queries in any part of the magazine is/are the 

person opinion of such experts/consultants/persons and are  not subscribed 

to by the PCLinuxOS Magazine.

2. The information in the PCLinuxOS Magazine is provided on an "AS IS" 

basis, and all warranties, expressed or implied of any kind, regarding any 

matter pertaining to any information, advice or replies are disclaimed and 

excluded.

3.  The PCLinuxOS Magazine and its associates shall not be liable, at any 

time, for damages (including, but not limited to, without limitation, damages 

of any kind) arising in contract,  rot or otherwise, from the use of or inability 

to use the magazine, or any of its contents, or from any action taken (or  

refrained from being taken) as a result of using the magazine or any such 

contents or for any failure of performance, error, omission, interruption, 

deletion, defect, delay in operation or transmission, computer virus, 

communications line failure, theft or destruction or unauthorized access to, 

alteration of, or  use of information contained on the magazine.

4.  No representations, warranties or guarantees whatsoever are   made as to 

the accuracy, adequacy, reliability, completeness, suitability, or applicability 

of the information to a particular  situation.

5. Certain links on the magazine lead to resources located on servers 

maintained by third parties over whom the PCLinuxOS Magazine has no 

control or connection, business or otherwise. These sites are external to the 

PCLinuxOS Magazine and by visiting these, you are doing so of your own 

accord and assume all responsibility and liability for such action.Material 

Submitted by UsersA majority of sections in the magazine contain materials 

submitted by users. The PCLinuxOS Magazine accepts no responsibility for 

the content, accuracy, conformity to applicable laws of such material.

Entire Agreement: These terms constitute the entire agreement between the 

parties with respect to the subject matter hereof and supersedes and replaces 

all prior or contemporaneous understandings or agreements, written or oral, 

regarding such subject matter.

Disclaimer

Posted by hunter0one, on August 4, 2025, running KDE.

https://www.edx.org/course/introduction-linux-linuxfoundationx-lfs101x-0#!
http://pclosmag.com
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by Agent Smith (Alessandro Ebersol)

Having your hard drive filled up and running 
out of space is not so much a possibility as a 
certainty. It will happen, and depending on how 
you use your computer, it may happen sooner 
rather than later.

It happened to me, thanks to my wine folder 
(Ah, Windows games...) and torrents, my 500 
GB hard drive was full to the brim. But how did 
I solve this problem?

How to increase your disk space with one (or 
more) extra disk(s) in Linux?

Linux has two options for adding extra disks. 
One is LVM, logical volume manager, and the 
other is to use the new hard disk as a pluggable 
mounted drive.

LVM, as defined by Wikipedia: “The Logical 
Volume Manager (LVM) is a device mapping 
framework for the Linux (and NetBSD) kernel 
that provides flexible management of logical 
volumes, creating an abstraction layer over 
physical storage. Originally developed in 1998 
by Heinz Mauelshagen at Sistina Software, with 
influence from the HP-UX volume manager 
design, LVM allows administrators to group 
physical volumes (PVs) into volume groups 
(VGs) and create logical volumes (LVs) that can 
span multiple disks. Logical volumes can be 
resized, moved, or captured while systems are 
running and support thin provisioning, caching, 
striping, mirroring, and RAID-type layouts. 
LVM is widely integrated into modern Linux 
distributions and supports root file system 
configurations, offering operational flexibility 
and dynamic storage management without 
service interruption.”

However, LVM should preferably be done 
before installing the operating system, since 
placing the root partition in LVM after 
installation is quite difficult, and it would 
probably be better to reinstall. In addition, it is 
not possible to simply create an LVM on an 
already mounted partition.

So, we will see how to add an extra hard drive 
as a pluggable unit within an already working 
system, which is what I did to solve my space 
shortage problems.

Steps to add another HD to your Linux 
system

In order to keep this tutorial structured, I will 
list the steps necessary to install an extra hard 
drive on an already installed and functioning 
Linux system.

 • Acquire the hard drive
 • Connect the new hard drive to the computer
 • Format the new hard drive
 • Create a mount point for the new hard drive
    (in the /media folder)
 • Add the hard drive to /etc/fstab (so that it
    mounts automatically at boot)
 • Restart the computer

And that's it, just use the new hard drive.

Step 1: Acquire the hard disk

I'm going to use a 500 GB Seagate hard drive 
that I had from another computer.

Step 2: Connect the hard drive to the 
computer

I connected the hard drive to the computer, and 
it was recognized as sdb (next page, top left).

Adding An Extra Hard Drive To Your PCLinuxOS
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Since it already had other partitions from 
previous installations, I removed them all and 
left the space unallocated.

Step 3: Format the new hard drive

I formatted the entire disk as a single partition in 
EXT4.

Detail: After formatting the disk, you need to 
copy its UUID so that we can insert the disk into 
/etc/fstab later.

 
Step 4: Create a mount point for the new 
hard drive (in the /media folder)

As root, I created the mount point for the new 
hard drive in the /media folder and named it 
hd_extra (you can name it whatever you want).

Step 5: Add the hard drive to /etc/fstab (so 
that it is automatically mounted at boot time)

As root, go to the /etc folder, find the fstab file, 
and edit it in your favorite plain text editor. I 
edited it with leafpad and added the entry for 
hd_extra, copying the same parameters that 
were in the entry for my /home partition and 

indicating the UUID of the new hard drive and 
its mount point (/media/hd_extra).

Step 6: Restart the computer

No major problems, just reboot so that the 
computer recognizes the new settings.

Step 7: Use the new hard drive

After restarting, the new hard drive is 
automatically mounted and appears in the file 
manager.

However, the new drive, hd_extra, does not 
have write permission. So, we have one more 
adjustment to make. 

Adding An Extra Hard Drive To Your PCLinuxOS
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Become root, open a terminal, and type 
chmod ­R 777 /media/hd_extra
(here should be the name you specified in your 
installation)

By doing this, you allow anyone to write to the 
new hard drive, making it possible to transfer 
your files to it.

In the case of the .wine folder, after moving it to 
the new hard drive, you need to create a 
symbolic link so that everything works 
normally.

In your /home folder, open a terminal and type 
the following command:
ln ­s /media/hd_extra/.wine ~/.wine

And that's it, Wine won't notice any difference 
and will continue to work as usual, but now it 
will store the files on the new hard drive. Note 
that the command I showed above is valid for 
my installation, since I used specific names. 
Another thing: The use of the new HD is not 
automatic, it must be specified, both as a 
download location and in torrent programs.

I hope you appreciate this simple method of 
adding extra space to your installation and can 
continue using your PCLinuxOS without 
running out of space for your files. I moved my 
wine folder, my downloads, torrents, and 
dosbox to the new hard drive, which freed up a 
lot of space in my /home.

SSccrreeeennsshhoott  SShhoowwccaassee

PCLinuxOS Magazine Graphics Special Edition, Volumes 1 - 4
Uhleash your GIMP & Inkscape skills.   Over 160 tutorials.   Grab your FREE copy now!

Posted by jogurtmen, on August 13, 2025, running KDE.

Adding An Extra Hard Drive To Your PCLinuxOS
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Editor’s Note: Tip Top Tips is a semi-monthly column in The PCLinuxOS 
Magazine. Periodically, we will feature – and possibly even expand upon – 
one tip from the PCLinuxOS forum. The magazine will not accept 
independent tip submissions specifically intended for inclusion in the Tip 
Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS 
forum’s “Tips & Tricks” section. Occasionally, we may run a “tip” posted 
elsewhere in the PCLinuxOS forum. Either way, share your tip in the 
forum, and it just may be selected for publication in The PCLinuxOS 
Magazine.

This month’s tip was shared by hunter0one.

Joe's Own Editor is an old-as-dirt text editor that I (hunter0one) learned 
since I didn't like nano. It is similar to WordStar or Emacs.

You can get it on PCLinuxOS by installing the joe package. Run it from 
the CLI using joe, or you can find it in your application launcher along 
with the other keybinding modes like Emacs and WordStar emulation. I

only use and will focus on the original (Ctrl + K centered) mode. From 
now on, I will use ^ in place of Ctrl, so Ctrl + K will be abbreviated 
^K.

JOE is a modeless editor so you can move around with the arrow keys. ^E 
will get you to the end of a line, and ^A will get you to the beginning. Now 
is a good time to mention a lot of keys use combos where you press ^K 
and then another key. For example, you can go to the top of a document 
with ^K U, and ^K V to go to the bottom.

Tip Top Tips: How To Use Joe's Own Editor (JOE)

http://www.fsf.org
https://www.pclinuxos.com/forum/viewtopic.php?p=3357#p3357
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Joe with a script loaded and the help menu displayed

Just Joe’s help menu

By default, there is a help menu to guide you. You can go to the next page 
of the help menu with Esc + . or to go back Esc + ,. You can toggle the 
help menu with ^K H.

If you want to delete an entire line, you would do ^Y, or from the start of 
the cursor, ^J. To select a block, you could do ^K B to start your selection, 

then ^K K for the end point. You can then do a number of things with the 
selected text. You can use ^K M to move it someplace else (effectively cut 
and paste), or ^K C to copy it.

If you do ^T, a new menu will pop up at the bottom of the editor which 
you can navigate. This lets you modify things like word wrap or the color 
scheme. Yes, JOE has color schemes like Vim or Neovim. You can press 
^C to get out of that menu. In fact, every action can be cancelled with ^C. 
You can search for or replace text with ^K F.

To exit JOE, you can do ^K Q. To save a file, press ^K S. If you notice any 
annoying DEADJOE files lying around, you can get rid of these by editing 
/etc/joe/joerc and removing one space before -nodeadjoe so that it's not 
green. You can actually tweak a lot of its behavior here, including having a 
backup path and custom keybindings, though you may want to back this 
file up or copy it to your home folder as ~/.joerc before you do that.

Editor’s Note: The C source code for Joe is hosted on SourceForge. On 
the project page on SourceForge, there’s a brief history of Joe, along with 
a full user manual. The current version of Joe is 4.6, which is the version 
in the PCLinuxOS repository. And, hunter0one is correct. Joe is older-
than-dirt (in software terms). It appears to have been around since around 
1988, with distant roots going back to 1984.

Tip Top Tips: How To Use Joe's Own Editor (JOE)

http://www.linuxfoundation.org/
https://joe-editor.sourceforge.io/
https://joe-editor.sourceforge.io/history.html
https://joe-editor.sourceforge.io/4.6/man.html
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by kalwisti (David Pardue)

   
I am a basic user of GIMP and know enough 
about its features to edit the screenshots that I 
include in my articles. One function, however, 
has always frustrated me: the ability to add 
arrows. The procedure seemed to be needlessly 
difficult, so I have preferred using Shutter when 
I need to add an arrow.

Shutter has multiple dependencies relying on 
perl and perl-gtk2; a recent issue with outdated 
perl and/or perl-gtk packages in PCLinuxOS 
caused Shutter to be removed/uninstalled. 
(Texstar wrote in the forum that perl and perl-
gtk are broken at the moment and “may be for a 
while.” Updating the perl-related packages is a 
daunting task, as more than 3,000 packages 
would need to be rebuilt.) I realized that it was 
time for me to learn how to draw arrows in 
GIMP.

The result: This task can be accomplished easily, 
thanks to the “arrow.scm” script created by 
programmer_ceds. My tutorial covers how to 
install this script and use it in GIMP 3.0.4.

GIMP 3.0 was released in March 2025, after 
seven years of effort by developers, artists, and 
members of the GIMP community. Meemaw 
provided an overview of this release's new 
features in the July 2025 issue of our magazine.

The Davies Media Design channel on YouTube 
has an in-depth review of the changes. Version 
3.0 runs natively on Wayland, while still 
continuing to run under X11.

Davies points out that the API in GIMP 3.0 
changed in many places; these changes break 
most of GIMP's legacy plugins — especially 
those with inactive development. Although this 
means inconvenience in the short term, it will 
improve the development of scripts and plugins 
for GIMP and will lay the foundation for a new 
generation of even better plugins.

Fortunately for us, the “arrow.scm” script has 
been updated to be compatible with GIMP 3.0. 
The script works by using functions that interact 
with GIMP's internal functions. “arrow.scm” is a 
modified version of an earlier script by B-
Ranger [Berengar Lehr]. (The .scm file 
extension is for a “Script-Fu” script based on an 
interpreted programming language called 
Scheme [which, in turn, is a variation of Lisp].)

The screenshot below displays a snippet of the 
script:

The advantage of this script method is that you 
can render an arrow to a desired size and 
position, rather than having to rely on using a 
pre-configured brush and manipulating its size, 
angle and other variables before adding it to 
your image.

Download the Arrow Script

First, you need to download the zipped script 
file [121 KB] from here.

In case that URL does not work properly, you 
may also download the file from my personal 
Box.com account.

How To Draw Arrows In GIMP 3.0

http://www.dosgamesarchive.com/
https://app.box.com/s/3w4xgycnbfycihw1xnxvu7roz584dnn7
http://programmer97.byethost10.com/Files/arrow.zip
https://www.youtube.com/watch?v=o2pZdfpmq5c
https://docs.gimp.org/3.0/en/gimp-scripting.html#idm7772
https://pclosmag.com/html/Issues/202507/page06.html
https://www.pclinuxos.com/forum/viewtopic.php?p=3933#p3933
https://pclinuxos.com/forum/viewtopic.php?p=3958
https://www.youtube.com/watch?v=ZGuqKbpWQy8
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Extract the Files

Use your favorite archive manager (Ark, 
Xarchiver, Engrampa, File Roller, etc.) to 
extract the files. You should see three files:

 • Arrow.scm
 • ArrowScriptNotes.pdf
      [contains instructions / notes]
 • arrow_V3.scm

Install the Arrow Script

Place the “arrow_V3.scm” file in the 
appropriate GIMP folder in your /home 
directory. In this case, that is
~/.config/GIMP/3.0/scripts.

Important: To avoid potential conflicts, do not 
copy the “arrow.scm” file into that folder. That 
script is for legacy versions of GIMP (2.10 and 
earlier).

Make sure to use only “arrow_V3.scm” with 
GIMP version 3.0.x.

Restart GIMP after installing the script.

Draw Straight Arrows

Make a path for your arrow to follow:

Click on the Paths Tool (or just type 
“B”) to begin creating a path.    

You will first specify the starting point. Click on 
the spot where you want the arrow head/pointer 
to be.

Notice that the map pin icon adds directionality 
to the first node that is created. It indicates the 
direction that your path is traveling. In the 
example below, the arrow head will point to the 
northeast.

Next, click to create the ending point/anchor.

Go to the Tools menu > select Arrow > then 
choose Arrow.

A dialog window will open with various settings 
(right, top).

Adjust the variables as you wish.
 
The arrow's color is determined by the setting of 
the active foreground color in the GIMP 
toolbox.
 
(The default values are reasonable — in my 
opinion — and produce attractive arrows.)

Note: You can revert your adjustments later, if 
desired, by choosing “Reset to Initial Values” 
or “Reset to Factory Defaults”:

Linux Training 
Courses & Classes

How To Draw Arrows In GIMP 3.0

http://www.fsf.org
http://www.beginlinux.com/
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Click the “OK” button in the bottom right 
corner of the dialog.

Voilà! Your arrow will appear.

Draw Curved Arrows

Follow the same steps outlined above to create a 
path.

Afterwards, bend the path by clicking and 
dragging the path.

While bending the path, you will see something 
like the screenshot below:

The result after calling the “arrow.scm” script:

The two screenshots below illustrate some of 
my experiments (with multiple adjustments to 
the Arrow variables). They will give you an idea 
of the results that you can achieve:

(The blue background textures and the Wilber 
stamp are standard brushes available to the 
Paintbrush tool.)

Additional Sources

The ArrowScriptNotes.pdf (bundled inside the 
“arrow.zip” file that you downloaded) is worth 
reading; it has a brief user guide as well as 
instructions for how to edit the default script 
values.

Since GIMP 3.0 has been released so recently, 
there are not yet many tutorials on it. So one of 
the best reference sources is the official User 
Manual.

The User Manual is available in other languages 
besides English. At the moment, the most 
complete translations appear to be in the 
Romance languages (except for Romanian), the 
Scandinavian languages, German, Dutch, and 
Russian.

The sections on plugins and scripts contain 
relevant information.

Summary

Despite my initial reluctance to draw arrows 
with GIMP, I was surprised how easy the task is 
— thanks to the “arrow.scm” script. Based on 
my testing, the script works reliably and allows 
you to control the placement of your arrows, 
their line thickness as well as the size of the 
arrow head. If your needs are fairly simple, this 
script fits the bill; it saves you the trouble of 
hunting down compatible arrow brush sets or 
creating your own brush(es).

How To Draw Arrows In GIMP 3.0

https://docs.gimp.org/3.0/en/gimp-creating-brush-quickly.html
https://docs.gimp.org/3.0/en/gimp-scripting.html#gimp-concepts-plugins
https://docs.gimp.org/3.0/en/gimp-concepts-script-fu.html
https://docs.gimp.org/3.0/en
https://docs.gimp.org/3.0/en
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Hazem Abbas
MEDevel.com
Reprinted with permission

Let's talk about that sinking feeling. You boot up 
your library, ready to revisit an old favorite, and 
it's just … gone.

Not corrupted. Not lost. Erased. By the 
company you paid. That's not a glitch; that's the 
new reality of digital ownership, and it just blew 
up into a full-blown war.

The Game That Started Everything!

Remember The Crew? That open-world racer 
you might have dropped $60 on? Ubisoft didn't 
just shut it down; they reached into your digital 
locker and deleted it. Servers went dark on

March 31, 2024, rendering the game unplayable.

But then, the kicker: they started revoking 
licenses and removing the game from players' 
Ubisoft Connect and Steam libraries entirely. 
You paid full price, and poof, your “purchase” 
vanished. This wasn't a technical hiccup; it was 
a corporate policy in action.

This nuclear move sparked outrage and a class-
action lawsuit filed by two California gamers. 
They argue Ubisoft violated consumer 
protection laws by making the game 
permanently inaccessible after purchase.

Ubisoft's response? A cold splash of reality: 
players never owned the game. They had a 
“limited license” to access a service, and that 
service has ended. They've filed motions to 
dismiss the lawsuit, doubling down on the idea 
that you don't have ownership rights over your 
digital purchases.

Essentially, they're saying, “You bought a ticket 
to a theme park, and when we decide to 
bulldoze the park, the ticket is worthless.”

This ignited a firestorm. Gamers worldwide 
realized the uncomfortable truth: buying a 
digital game, movie, song, or even software 
often means you're just renting access, governed 
by lengthy Terms of Service you never read.

The fundamental rights we associate with 
ownership, like ongoing access, the ability to 
lend it to a friend, or resell it, are almost always 
stripped away in the digital realm. The 
traditional model of ownership has been 
replaced by restrictive licensing agreements.

Stop Killing Games (SKG)

Enter Stop Killing Games (SKG). What started 
as a reaction to The Crew's demise, has 
snowballed into a global movement. Their 
petition (now closed), demanding new EU laws 
to prevent publishers from remotely disabling 
games consumers have paid for, has now 
gathered a staggering 1.4 million signatures. 
Yes, you read that right. 1.4 million people 
screaming, “We paid for this, it should be ours!”

The European Commission is now reviewing 
the petition. If validated, it could lead to 
legislative proposals protecting digital 
ownership rights and ensuring game 
preservation. Even a Vice President of the 
European Parliament has voiced support, calling 
for laws to prevent the permanent shutdown of 
purchased digital games. This is no longer just a 
gamer issue; it's a consumer rights battle for the 
digital age.

Ubisoft's CEO, Yves Guillemot, responded not 
with empathy, but with corporate logic:

You Don't Own That Game (And That App On Your Phone?
Yeah, You Don't Own That Either)

https://medevel.com/author/hazem/
https://medevel.com/you-dont-own-that-game/
https://www.stopkillinggames.com/
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“Support for all games cannot last forever”. He 
framed online games explicitly as a service that 
will inevitably end.

“You provide a service, but nothing is written in 
stone and at some point the service may be 
discontinued. Nothing is eternal,” he stated. It's 
a brutally honest, yet deeply unsettling, 
admission of the industry's current model. But is 
that acceptable? Should paying $70 for a game 
really mean you're just subscribing to a 
temporary service with no guarantee of 
longevity?

The Problem Isn't Just Games. It's 
Everything Digital.

Think about that expensive photo editing app 
you bought. The music library you built on 
iTunes. The e-books filling your digital shelf. In 
almost all cases, you don't own these. You've 
purchased a license to use them under specific, 
often changeable, terms. The company can alter 
features, sunset support, or, in extreme cases, 
potentially restrict access.

The rights encompassed by true ownership, 
ongoing access, availability, resale, are largely 
aspirational for digital content. The shift from 
owning physical media to accessing digital 
content has quietly eroded consumer rights.

So, What Should Gamers (and All Digital 
Consumers) Do?

Wake Up & Read the Fine Print: Understand 
that “Buy Now” usually means “License to 
Access.” Those Terms of Service are the 
contract. Pay attention to clauses about service 
lifespans and license revocation.

Vote With Your Wallet (and Your Voice): 
Support developers and publishers who 
champion longevity, offline modes, and 
modding communities that can preserve games. 
Boycott companies that engage in predatory 
delisting practices.

Join the Fight: Sign the Stop Killing Games 
petition if you're an EU citizen. This movement 
is our best shot at forcing legal recognition of 
digital ownership rights. Share it. Talk about it. 
Make noise. (Editor’s note: the petition has 
closed, but you can review the petition page 
here.)

Demand Transparency: Companies should be 
crystal clear about the lifespan of online services 
and what happens to your purchase when they 
end. No more burying this in legalese.

Consider Physical (When Possible): For 
games that offer it, a physical copy, even if it 
requires online activation, often feels like a 
more tangible asset, though even this isn't 
foolproof anymore.

End Line

I believe, if a company permanently kills a 
product you paid full price for — like Ubisoft 
did with The Crew — they owe you a refund. 
You didn’t buy a temporary service; you were 
led to believe you owned a game.

Taking it away without compensation is no 
different than selling a car and then remotely 
bricking its engine. Charging $70 for access to a 
finite, non-guaranteed experience without 
refund options is deceptive.

Consumers deserve transparency and recourse. 
If the product vanishes, the money should come 
back, ownership means something, or it means 
nothing. Companies profiting from digital sales 
while dodging long-term responsibility is 
unethical. Refunds aren’t generosity; they’re 
justice.

The battle for digital ownership is just 
beginning. Ubisoft drew a line in the sand with 
The Crew. The players responded with a petition 
of historic scale.

The EU is listening. The question is no longer if 
we need to redefine ownership in the digital 
world, but how. Will we accept being perpetual 
renters in a world we've paid to access? Or will 
we fight for the right to truly own the digital 
things we buy?, and I’ve replaced them

The servers may shut down, but the fight for our 
rights is just powering up.

Linux DocsLinux 
Man Pages

You Don't Own That Game (And That App On Your Phone? Yeah, You Don't Own That Either)

http://www.commandlinefu.com
http://www.die.net/
https://www.stopkillinggames.com/eci
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About The Site & Author

Medevel.com is a restart of an old project 
Goomedic.com when we used to blog about 
medical/ healthcare related open-source 
projects. The writers are medical doctors also 
doing software development, as well as open-
source enthusiasts and Advanced Linux users.

Medevel.com is writing articles about open 
source with a primary focus on medical, science 
projects.

Medevel.com is on a mission to promote open 
source to healthcare sector users like doctors, 
nurses, healthcare IT specialists, open-source 
community, researchers.

Medevel.com's team is writing about 
visualization, medical imaging, lab-ware, 
medical records (EMR, EHR), clinical practice 
management software, digital pathology, 
medical simulation, & data analytics apps.

Medevel.com is focusing on:

  • Open source technologies for Healthcare
  • Privacy-focused applications
  • Medical Imaging: DICOM/PACS solutions
  • Electronic Medical Records/Electronic
     Health Records
  • Medical Visualization & Simulation
  • HIPAA & GDPR compliant solutions
  • Self-hosted Open-source solutions
  • Linux Applications
  • Medical Mobile apps for Doctors & patients
     (Android, & iOS)

We are also writing reviews about some open-
source software, & projects which we find useful 
for our audience, aiming to help open-source 
software developers to reach more audiences.

Authors

Hamza Mu: A physician with programming 
skills, Linux user since late 1990s, Open-source 
supporter. He is also a former PCLinuxOS user.

Desoky Mo: A physician interested in Open 
Source, programming, machine learning, AI and 
technology in general.

M.Hanny Sabbagh: Computer science and 
engineering graduate, with an on-going M.Sc in 
computer science. Founder of FOSSPost.org. An 
open-source software developer and technical 
writer for more than 10 years.

SSccrreeeennsshhoott  SShhoowwccaassee

Posted by Just19, on August 8, 2025, running KDE.

You Don't Own That Game (And That App On Your Phone? Yeah, You Don't Own That Either

http://Medevel.com
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by Agent Smith (Alessandro Ebersol)

And so begins the end of freedom on the 
Internet.

George Orwell must be rolling in his grave

England is implementing an internet access law 
called the Online Safety Act. It came into force 
in July 2025 and is considered one of the 
world's strictest laws for protecting children in 
the digital environment.

The “official” narrative is that the Online Safety 
Act was created in response to a series of 
tragedies and growing concerns about the 
harmful impact of the internet on the lives of 
children and adolescents. It represents an 
ambitious attempt to make the digital 
environment safer, especially for young people. 
Well, that's what they say. But who is behind 
this law?

Party and politician who led the approval

 • Conservative Party: The original bill was
    drafted and promoted by the Conservative
    Party, which governed the United Kingdom
    during the development of the legislation

 • Peter Kyle (Labor Party): Although the bill
    was initiated by the Conservatives, the
    National Secretary for Technology, Peter
    Kyle, of the Labor Party, was one of the most
    vocal figures in defending the final version of
    the law. He made strong statements, saying
    that those who oppose the law are “on the
    side of predators and pedophiles”

Now, the reasons for having laws to control 
internet access are, at first glance, very good and 
justified. After all, we want to protect children 
from accessing content that they should not be 
accessing. And when the two main parties in 
England unite in a common effort, there must be 
a very strong reason for it. And there is, but it is 
not any of those being propagated.

Although England's two largest political forces 
are in favor of the online safety act, Nigel 
Farage of the Reform UK party strongly 
opposed the law, claiming that it threatens 
freedom of expression. Farage promised to 
repeal the legislation if his party wins the next 
election.

Nigel Farage

Now, when the so-called right-wing populist 
extremist is the most reasonable voice in the 
room, something very strange is going on. 
Otherwise, why would England's two largest 
parties want to pass a law that will inevitably 
curtail the right to individual expression on the 
internet?

Without delving too deeply into the English 
political environment, since that is not the scope 
of this article, it can be said that, since Tony 
Blair's Labour Party, the policies of Labour and 
the Conservatives have been almost identical, 
with rare differences: austerity, government 
downsizing, privatization, and revision of social 
welfare policies. In short, the two seem more 
like bridge partners than political adversaries. 
And with the new law, they may be trying to 
suppress Farage's party, which has grown

The Online Safety Act
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impressively in recent years in England. But 
let's leave that aside, since we are interested in 
the effects of the law, not its causes.

The road to hell is paved with good 
intentions.

As the saying above goes, good intentions can 
ruin everything, because what starts out as 
“protecting children” can end very badly. Let's 
see how the Online Safety Act works and why it 
was born already ineffective.

What led to the Online Safety Act

The Online Safety Act was prompted by a series 
of tragic incidents and concrete concerns about 
online safety, especially in relation to the 
protection of children and young people. Here 
are some of the key events and reasons that 
contributed to its creation:

 • Molly Russell's suicide (2017):
    Molly, a British teenager, committed suicide
    after being exposed to content about self-
    harm and suicide on social media. The case
    sparked public outrage and led to an
    investigation into the impact of social media
    on young people's mental health.

 • Breck Bednar case (2014):
    Breck, a 14-year-old boy, was murdered by a
    man he met online. The case highlighted the
    safety risks associated with using the internet
    and the need to protect children from online
    predators.

 • Rising in Cyberbullying Cases:
    Reports of online bullying and its devastating
    consequences for young people's mental
    health have been on the rise, leading to
    greater awareness of the need for regulation.

All these cases caused an uproar in society, and, 
taking advantage of this public outcry, 
politicians created the Online Safety Act. 
However, before the OSA, Australia already had 
its own law, the Australian Online Safety Act, 
AOSA.

How the Online Safety Act works

OSA operates aggressively on the side of online 
platforms, due to the identification requirements 
it forces them to implement and the massive 
regulation of the content displayed.

Identification of Harmful Content: Platforms 
must identify and remove content that may be 
harmful, such as pornography, hate speech, and 
material that promotes self-harm or suicide.

Content Classification: Platforms should 
classify content according to its potential harm 
and implement specific measures for each 
category.

At OSA, one of the fundamental requirements is 
mandatory age verification. This must be 
implemented by digital platforms:

  1. Identity Verification: Platforms may
      request identity documents to confirm the
      age of users. This may include:

     • Passports: An official document proving the
        user's identity and age.

     • Identity Cards: Documents issued by
        governments that contain personal
        information and a photo of the user.

     • Student ID cards: In some cases, student ID
        cards that contain the date of birth may be
        accepted.
      
  2. Verification Technologies: Platforms can
      use specific technologies to verify users'
      ages without the need to collect physical
      documents. These may include:
      
     • Biometric Verification: Use of facial
        recognition or fingerprint recognition to
        confirm the user's identity and age.

     • Third-Party Verification Systems:
        Partnerships with companies specializing
        in identity verification that can securely
        validate users' ages.
      
  3. Self­Declaration Methods: Although less
      secure, some self-declaration methods can
      be used, where users provide their age when
      registering. However, these methods must be
      supplemented by other measures to ensure
      accuracy:

      • Age Declaration: Users may be asked to
        declare their age during registration, but
        this should be accompanied by additional
        checks
      

The Online Safety Act
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  4. Data Analysis Algorithms: Platforms can
      use algorithms to analyze user behavior and
      determine the likelihood of their age. This
      may include:

     • Usage Pattern Analysis: Monitoring how
        users interact with content to identify
        typical behaviors of different age groups
      
And all this to protect our “children.” But we 
will see below that these “good intentions” are 
fallacies, and that the target, despite being 
“children,” is actually the elderly, and that such 
new legal practices open up serious security 
loopholes.

Biometrics will save the Internet!

At first glance, this may seem like a very good 
thing. After all, how many bots would disappear 
from the internet if only real people accessed it?

And since these measures came into effect at the 
end of July, social media platforms Reddit, 
Bluesky, Discord, and X have introduced age 
checks to prevent children from viewing 
harmful content on their sites.

Pornographic sites such as Pornhub and 
YouPorn have implemented age checks on their 
sites, now requiring users to submit a 
government-issued ID, provide an email address 
for the technology to analyze other online 
services where it has been used, or submit their 
information to a third-party provider for age 
verification. Sites such as Spotify are also

requiring users to submit facial scans to third-
party digital identity company Yoti in order to 
access content rated 18+. 

Unfortunately, circumventing biometric 
requirements is one of the easiest things to do 
today, and children and young people, who are 
digital natives (born with computers and 
smartphones), can easily bypass these 
requirements. And besides, what could go 
wrong with facial recognition?

Facial recognition: easy to crack and a huge 
risk!

Well, first, let's address facial recognition: Since 
OSA is being done very sloppily, there are 
several ways to circumvent its requirements. 
And kids already know this and are using 
computer games to circumvent facial 
recognition.

People are already using selfies of Sam Porter 
Bridges (the protagonist of Death Stranding) to 
bypass Discord's age verification, thereby 
gaining authorized access without actually 
having their age verified and protecting the 
privacy of the user who used this feature.

Taking selfies with Death Stranding

In addition, VPNs also completely nullify the 
“effectiveness” of the law, since, in order to 
verify age, online services test the range of IP 
addresses that access the website and only apply 
the age test if the user's IP address comes from 
England. Thus, by changing the access IP to any 
other country outside the jurisdiction of this law, 
these digital locks become ineffective.

But why not use facial recognition? After all, 
that would put an end to fakes on the internet. It 
would be great, except it wouldn't. Who has 
used facial recognition lately, and it went very 
wrong?

Tea App – A cautionary tale

Recently, there was a massive leak of personal 
data from the website https://
www.teaforwomen.com/, an online dating app 
exclusively for women based in the United 
States, with over four million users, which stood 
out for its ability to flag men as red flags, 
serving as a warning to other women interested 
in dating them.

To sign up for the site and access the platform, 
you would need to be a woman, and, attention 
here: women must submit a selfie and an

The Online Safety Act
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official ID to verify their identity. Once 
accepted, they are encouraged to share 
experiences, warn about risky situations, and 
connect with others for mutual support and 
protection. Of course, once again, we have 
“good intentions” that went very wrong, as the 
site has suffered at least two significant data 
breaches. The first breach, confirmed on July 
25, 2025, involved the exposure of 
approximately 72,000 images, including selfies 
and identity documents, while a second breach 
revealed access to more than 1.1 million private 
messages. Now, with all the selfies, personal 
data, and everything else, such leaked data is 
delighting online scammers, who will have 
material for internet scams for years to come. In 
addition, the leaked data about the men on the 
website is generating public outcry among these 
men to sue the website for defamation and take 
it down permanently, as the comments made 
about the men on the platform border on 
harassment and defamation.

That is why facial recognition should not be 
used on public platforms, as the risk of things 
going off the rails is too big.

But the law will protect children!

No, we have already seen that this is not the 
case. But the point is to use very sensitive 
situations in the present day to generate public 
outcry that facilitates the passage of restrictive 
laws that will censor the internet. And for older 
people. Yes, young people, digital natives, know 
how to get around the restrictions imposed by 
laws, but older people do not.

How did we get here?

Unfortunately, nowadays, we no longer have 
objective truth, but narratives. And at a time 
when news agencies report the facts to the 
whole world, smaller agencies simply replicate 
the information from agencies such as Reuters, 
AFP, Bloomberg, and the like, creating a 
cascade effect. Thus, with a handful of so-called 
“official” news sources around the world, it is 
very easy to create narratives that favor political 
interests. Now, the horizontal nature of the 
internet has favored the emergence of 
independent journalism, which has become a 
way to challenge official narratives. 

We must note that the OSA is not an isolated 
case, but at a time when contradictory narratives 
are suppressed, it is an effort to control 
expression on the global internet. In this effort 
to censor the internet, the following countries 
already have laws in place regarding internet 
access control: Australia, the United Kingdom, 
the European Union, and even the United States 
has several laws to “protect children,” but they 
are not federal.

In Brazil, there is a movement, thanks to public 
outcry over YouTube videos by some notorious 
YouTubers, who are now being prosecuted. 
Well, the timing is strange, really strange, that, 
like a game of dominoes, in which each stone 
falls in sequence, now these “hidden forces” are 
putting pressure on Brazil.

Who judges the judges?

One of the objectives of the OSA is 
“Identification of Harmful Content: Platforms 
must identify and remove content that may be 
harmful, such as pornography, hate speech, and 
material that promotes self-harm or suicide.”

However, these terms are so vague that they 
could mean anything. An opinion about a 
particular person or subject could be interpreted 
as hate speech, depending on how it is phrased. 
And the question remains: Who will judge what 
is or is not hate speech? What is or is not 
appropriate for children? Sure, there are things 
that are evidently harmful, but what about the 
rest ? What is appropriate for one, might not be 
for others.

That's not how you combat fake news.

Once again, the veiled objective of these laws is 
also to suppress fake news, but fake news 
cannot be combated with censorship. Fake news 
are combated with quality information, 
supported by reliable data and research, which 
can bring information closer to reality. When 
contradictory information is prevented, under 
the guise of combating fake news, only official 
fake news are accepted, without the right to 
contest them. This is not combating fake news, 
but rather imposing an official narrative and 
making it impossible to contest it.

The Online Safety Act
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Is there hope for freedom of expression on 
the internet?

Users in the United Kingdom have already made 
their dissatisfaction with the OSA clear: Within 
days of the age verification coming into effect, 
VPN apps became the most downloaded apps 
on Apple's App Store in the UK, and a petition 
calling for the repeal of the Online Safety Bill 
recently reached over 400,000 signatures. The 
internet must remain a place where all voices 
can be heard, free from discrimination or 
censorship by government agencies, and efforts 
must be made to truly make the internet safe for 
children, rather than using them as a pretext to 
impose Draconian laws whose objectives are far 
from what they appear to be.

A picture is worth a thousand words

I saved this cartoon by American cartoonist John 
Jonik a while ago. In its direct simplicity, it 
perfectly captures the moment we are living in. I 
think this cartoon was drawn around 2012 or 
2015.

SSccrreeeennsshhoott  SShhoowwccaassee
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Posted by kc1di, on August 7, 2025, running KDE.
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by The PCLinuxOS Community

Relevant to all PCLinuxOS editions.

ErrorMessage displayed

pkgProblemResolver::Resolve generated 
breaks, this may be caused by held 
packages.

This is an error produced when trying to update 
your PCLinuxOS distribution.

Situations that generate this error:

    • While updating via Synaptic

    • While updating via command line using
      'apt-get' 

Cause of the error

The cause is most likely some conflicting names 
of the packages between older packages on your 
computer and those on the update server, 

resulting in unresolved dependency.

A screenshot of Synaptic throwing this error is 
not available. Here is a sample command line 
output including the error.

After issuing the following command:

apt-get dist-upgrade

you get this output

Reading Package Lists... Done
Building Dependency Tree... Done
Calculating Upgrade... Failed
The following packages have unmet 
dependencies:
 plymouth-theme-coffee: Obsoletes: 
plymouth-theme-Coffee
E: Error, pkgProblemResolver::Resolve 

generated breaks, this may be caused by 
held packages.

This particular example was due to the new 
package being named in all lower case, 
compared to the lone uppercase for Coffee in the 
earlier version.
The Solution

    • Make a note of the offending package(s)

    • Open Synaptic

    • Mark the offending package for complete
       removal

    • Click Apply

Then your update should proceed smoothly. 
After your update is complete, reinstall the 
updated version.

Remember that everything in Linux is case-
sensitive. In Linux, “coffee” and “Coffee” and 
“COFFEE” are three totally different things.

View this PCLinuxOS Wiki Knowledgebase article here.

Linux Training 
Courses & Classes

Wiki Pick: PkgProblemResolver

http://www.beginlinux.com/
http://www.commandlinefu.com
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https://pclosusers.com/wiki/index.php?title=PkgProblemResolver
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Serves: 12

INGREDIENTS:

nonstick cooking spray
two 10-ounce bags (566g; 11 heaping cups)
    miniature marshmallows, divided
1/2 cup (8 Tbsp; 113g) unsalted butter
1 teaspoon pure vanilla extract
pinch salt
7 cups (190g) crispy rice cereal
1 and 1/2 cups graham crackers, broken into
    small pieces (6 graham crackers; 90g)
3 Hershey's milk chocolate bars, broken into
    pieces (1 heaping cup; 129g)

Topping (optional)
1–2 Hershey's milk chocolate bar(s), melted

DIRECTIONS:

Preheat the oven's broiler on high, about 5 
minutes.

Toast half the marshmallows: Line a baking 
sheet with aluminum foil. Spray the foil with 
nonstick cooking spray. Spread half of the mini 
marshmallows (one 10-ounce bag) in a single 
layer on the prepared baking sheet. Broil until 
the marshmallows are toasted and golden-brown 
on top, which only takes a couple of minutes. 
Keep a close eye on them so they don’t burn. 
Remove from the oven and set aside.

Line a 9×13-inch baking pan with parchment 
paper. Lightly grease the parchment. I always 
use a very light mist of nonstick spray. Set aside.

Melt the butter in a very large pot over medium 
heat. Once melted, add the remaining 10 ounces 
of (non-toasted) marshmallows. Stir the mixture 
with a rubber spatula until the marshmallows are 
completely melted.

Remove from heat, then immediately stir in the 
vanilla extract and salt. Fold in the crispy rice 
cereal and graham cracker pieces until mostly

combined. Allow to slightly cool for a minute or 
two, and then fold in the chocolate and toasted 
marshmallows.

Transfer mixture to prepared pan. Using a 
rubber spatula (greasing it lightly helps), gently 
spread mixture to fit the pan. Lightly grease the 
back of a flat spatula and very gently press the 
mixture down into the pan. Do not pack it down 
with force, just lightly press down until it is 
secure in the pan.

Allow treats to set for at least 1 hour at room 
temperature, and up to 1 day. Cover tightly if 
leaving out for more than a few hours.

Optional topping: Drizzle melted chocolate 
over the top of the cooled treats, if using, and 
place in the refrigerator for about 15–20 minutes 
to set the chocolate. (Not too much longer, or 
the treats will be too hard to cut.)

PCLinuxOS Recipe Corner Bonus

Rice Krispie S'mores
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Lift the rice krispie treats as a whole out of the 
pan using the edges of the parchment paper. Cut 
into squares.

Cover and store leftover treats at room 
temperature for up to 3 days. To store, place in 
an airtight container, with sheets of parchment 
or wax paper between layers.

NOTES:

Freezing Instructions:  Rice krispie treats aren't 
the best dessert to freeze because the texture 
isn't always completely the same after thawing. 
That being said, you can still freeze these 
squares. Freeze in layers between sheets of 
parchment or wax paper in a freezer-friendly 
container for up to 2 months. Thaw at room 
temperature before serving.

Chocolate: Instead of Hershey's bars in the 
treats, you can use chocolate chips. For the 
topping, you can use any milk or semi-sweet/
dark chocolate.

NUTRITION:
per serving

Calories: 110     Carbs: 20.3g     Sodium: 915mg
Fiber: 0.1g         Protein: 0.9g

SSccrreeeennsshhoott  SShhoowwccaassee

Help PCLinuxOS Thrive & Survive

DONATE
TODAY

Posted by Meemaw, on August 5, 2025, running Xfce.

PCLinuxOS Recipe Corner Bonus: Rice Krispie S'mores

https://www.patreon.com/pclinuxos
http://www.linuxforum.com
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can 
view them here. You have seven (7) letter 
tiles with which to make as long of a word 
as you possibly can. Words are based on 
the English language. Non-English 
language words are NOT allowed.
2. Red letters are scored double points. 
Green letters are scored triple points.
3. Add up the score of all the letters that 
you used. Unused letters are not scored. 
For red or green letters, apply the 
multiplier when tallying up your score. 
Next, apply any additional scoring 
multipliers, such as double or triple word 
score.
4. An additional 50 points is added for 
using all seven (7) of your tiles in a set to 
make your word. You will not necessarily 
be able to use all seven (7) of the letters in 
your set to form a “legal” word.
5. In case you are having difficulty seeing 
the point value on the letter tiles, here is a 
list of how they are scored:
  0 points: 2 blank tiles
  1 point: E, A, I, O, N, R, T, L, S, U
  2 points: D, G
  3 points: B, C, M, P
  4 points: F, H, V, W, Y
  5 points: K
  8 points: J, X
  10 points: Q, Z
6. Optionally, a time limit of 60 minutes 
should apply to the game, averaging to 12 
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each 
Sudoku puzzle. The only way the puzzle can be considered 
solved correctly is when all 81 boxes contain numbers and the 
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be pre ‐
filled for you. You cannot change these numbers in the course 
of the game.

Each column must contain all of the numbers 1 through 9 and 
no two numbers in the same column of a Sudoku puzzle can 
be the same. Each row must contain all of the numbers 1 
through 9 and no two numbers in the same row of a Sudoku 
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no 
two numbers in the same block of a Sudoku puzzle can be the 
same. D

o
w

n
lo

ad
 P

u
zz

le
 S

o
lu

ti
o

n
s 

H
er

e

Possible score 225, average score 158.

PCLinuxOS Puzzled Partitions

https://pclosmag.com/html/Issues/202509/files/2025-09-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/


PCLinuxOS Magazine Page 44

ARITHMETIC ASSIGNMENT

ATLAS BOOK

CALCULATOR CALENDAR

CLIPBOARD COLORED PENCILS

COMPASS COMPUTER

CONSTRUCTION PAPER CRAYONS

DESK DICTIONARY

ENCYCLOPEDIA EXAMINATION

EXPERIMENT GEOGRAPHY

GLOBE GRADES

GYM HISTORY

LANGUAGE LAPTOP

LEARN LIBRARY

MATHEMATICS       PHYSICAL EDUCATION

PRINCIPAL PRINTER

PROTRACTOR PUPIL

QUIZ READING

RULER SCIENCE

TEACHER VOCABULARY

WATERCOLORS WORD PROBLEMS
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1. A procedure carried out to support or refute a hypothesis.
2. A person who helps students to acquire knowledge and
    competence in one or more areas.
3. The observation, identification, description, experimental
    investigation, and theoretical explanation of phenomena.
4. A structured system of communication that consists of grammar
    and vocabulary.
5. An electronic or mechanical device for the performance of
    mathematical computations.
6. A place in which reading materials or musical and video
    recordings, are kept for use or lending.
7. Training in physical fitness and in skills requiring or promoting
    such fitness.
8. A table showing the months, weeks, and days in at least one
    specific year.
9.  A spherical model of Earth or another celestial body.
10. A short oral or written test used to assess knowledge on a
      specific topic.
11. To gain knowledge of or skill in through study, instruction, or
      experience.
12. A task or piece of work given to someone, often as part of their
      studies or job.
13. An elementary branch of mathematics that deals with numerical
      operations like addition, subtraction, multiplication, and
      division.
14. A machine that can be programmed to carry out sequences of
      arithmetic or logical operations.
15. A book or bound collection of maps.

PCLinuxOS Puzzled Partitions
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Posted by old-man, on August 12, 2025, running KDE.

Posted by tschommer, on August 11, 2025, running KDE.

Posted by old-polack, on August 1, 2025, running KDE.

Posted by youcantoo, on August 4, 2025, running KDE.
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